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WHAT IS QUEST FOR GLORY?

Quest for Glory combines the character development and combat of fantasy role-
playing games with the basic adventure game concept of exploring a world and solving
its puzzles. Trial by Fire is the second Quest for Glory scenario.

The essence of role-playing is that you must try to think as your character would
when faced with a dilemma. In Quest for Glory II, you can choose from three basic
character types — the strong fighter, the mysterious magician, or the wily thief. Each
has the same goal: to find Arus al-Din and restore him to the rank of Emir of Raseir.
Each character will, however, set about accomplishing that goal in a different way. The
magician may use spells to overcome some obstacles, but might not survive a pitched
battle with a monster. The thief must find a crafty way around the same problem that
the fighter or magic user would approach directly,

Experience can be a tremendous asset to you as a hero, Y our attributes will improve
as you play the game. Tasks that are beyond your ability early on may become less dif-
ficult as your skills improve.

Conversation is a very important element of T'rial by Fire. You will meet many
strange people and creatures in Shapeir. To learn about your surroundings and
your quest, it will be necessary to speak with everyone you meet. Like your char-
acter, the beings you meet will have distinct personalities, and their skill and
knowledge may lie in different areas. You'll want to ask specific questions, and
find out all you can.

Every hero must deal with his share of foul and ferocious monsters, If you want to be
a hero, you'll have to fight or avoid them, as they don 't tend to favor discussion. Each
battle you fight will provide you with valuable experience, and many victories will
yield treasure that you will need to buy food and equipment.

A hero’s life isn't always serious, though. Between desperate encounters with ter-
rible monsters and life-and- death decisions lie many light-hearted, humorous and
downright silly moments. Shapeir is a strange place with a multi-faceted personality,
as you will soon see.

Creating a Character

Before beginning your adventure, you’ll choose from three basic character types —
The Fighter, The Magic User, or The Thief. Your selection will determine much
about the sorts of obstacles you will encounter, and the means by which you will over-

come them. Choose CREATE CHARACTER from the starting screen. You will see
the character selection screen. Choose the highlighted character from the character
selection screen by pressing the [ENTER] key or by pointing with your mouse and
clicking the button (multi-button mouse users will use the /eff button).

Importing a Character From Spielburg

If you successfully completed Quest For Glory I: So You Want To Be A Hero, your
hero can travel to Shapeir by magic carpet and once again help you defeat evil.

Locate the diskette on which you saved your hero after the QF GI victory celebration.

Load Trial By Fire, insert the saved hero diskette into a drive and choose IMPORT
CHARACTER. A file selector box will appear on the screen, listing the files on the
disk in drive A:. If your Hero is in another disk or directory, choose CHANGE DIREC-
TORY.

Use your mouse or [Arrow] keys to highlight the name of the file containing your
saved Hero, then click on the Import box or press [ENTER].

To go back to the initial selection screen, choose CANCEL or press [ENTER].

Each type of character comes with its own set of skills and abilities, some specific to
the character type, some common to all three. Every type has pre-assigned point values
for appropriate abilities. In addition, you will begin the game with a 50 point *pool’ to
assign to the areas in which you wish your character to be strongest (see Assigning
Skill Points, below.

After you have chosen a character, you must name it. You may type in any name you
like.
The Fighter

The Fighter depends upon his skill with weapons, his strength and his vitality to sur-
vive the rigors of life as a Hero. His weapon is his sword, and his best defense is his
shield. We recommend that you play a Fighter if this is your first Quest for Glory
adventure.

The Magic User

The Magic User must rely upon his intelligence and the successful casting of magic
spells. He can best protect himself by avoiding close combat.



The Thief

The Thief counts on his skills, stealth, and agility. His weapon of choice is the dag-
ger, and he prefers to throw it from a distance. He can best defend himself in combat by
dodging.

Name : [Fonad the Barbarian |

Strength 80 Weapon Use 70

Intelligence 40  Parry B0
Apility 60  Dodge a0
Vitality 70 Stealth 0
Luck 50  PicK Locks 0D

Throwing 50
| | [Climbing 10
Points Available Magic 0

10750 ] TAPB to move around,
, Arrows to adjust ralues,
Health Points 76 /76

Stamina Points 65 / 65 Start Game
IFlagic Points 0 /0
Assigning Skill Points

To highlight a skill, use the mouse cursor or the up and down [Arrow] keys. To as-
sign points to a skill, press the right [Arrow] key. Each time the right [Arrow]| key is
pressed, 5 points will be assigned to the highlighted skill. Press the left [ Arrow] key to
subtract 5 points from a skill. (You may not reduce skill points below the original value
of that skill.) For ‘fine tuning’ use the [+] and [-] keys to add or subtract one point at a
time.

To attain a skill not normally available to your character type (such as lock-picking
for a fighter), choose the desired skill from the skill menu and assign points using the
procedure described above. Acquiring a new skill costs 10 points, which means the
minimum skill level of 5 will require 15 points from the ‘Points Available’ pool. These
will be assigned automatically.

Points for Health, Stamina or Magic cannot be changed by you directly. The values
for these attributes will change automatically as you gain experience, suffer damage
and modify certain skills,

Strength is important in performing physical activities, especially combat. The
Fighter must be strong to be effective.

Intelligence will enable the Magic User to successfully learn and cast spells, and
will benefit all characters when engaged in mental activities, such as out-thinking op-
ponents in combat, or trying to think effectively.

Agility is important during combat, and vital to lock-picking and stealth. The Thief
cannot prosper without high agility.

Vitality determines how much damage a character can sustain, and how quickly he
will recover from damage and strenuous physical activity. High vitality is particular-
ly useful to the Fighter.

Luck can aid you in many subtle and mysterious ways, and is especially important
to the Thief.

Honor aids your interactions with those characters who live their lives by a code of
honor. Honor points must be earned — they can not be assigned directly.

Skills:

Weapon Skill determines the character’s ability to land a successful blow in com-
bat.

Parry is the ability to block an opponent’s blow using a weapon or shield.
Dodge is a skill used to avoid a blow by ducking or sidestepping it.

Stealth is the art of moving quietly and discreetly, taking advantage of shadows
and other camouflage when sneaking around.

Pick Locks is the skill that allows a character to triumph over locked doors, chests,
etc. A lock pick or thief’s tool kit is necessary to use this skill.

Throw determines your character’s aptitude for throwing and accurately hitting a
target with a small object such as a rock or a dagger.

Climb is the skill that allows a character to scale difficult surfaces.
Magic is the basic skill required to learn and cast magical spells.

Communication is the skill of putting your thoughts in order and expressing your-
self effectively to others.



Each character also possesses attributes that are set automatically based on certain
skills and abilities:

Health Points gauge the amount of damage a character can suffer before he will
die.

Stamina Points determine how much energy a character has to perform physical
activities. When Stamina points are low, the character is tired. He will fight less
effectively, and may be injured more easily.

Magic Points measure the amount of mana or magical energy a character has, and
therefore how much magic he can perform. When magic points are gone, the
character will be unable to cast spells.

Skills and abilities improve with practice. The skills your character exercises
frequently will improve more rapidly, while those left unused will remain fixed at their
original levels. Your character can only advance in skills in which he has at least five

points.
The Story Thus Far...

You begin Trial By Fire flush with the success of your last adventure (as depicted in
Quest for Gloryl: So You Want To Be A Hero). As you recall, you arrived in Spielburg
with little but your Famous Adventurers’ Correspondence School diploma. But now
you are the Hero of Spielburg, having defeated the brigands and driven Baba Yaga
from the valley. You also made many important friends, including the Archmage
Erasmus (and his faithful companion Fenrus), and the Baron Stefan von Speilburg.
Your friendship with the Kattas Shema and Shameen, and Abdulla Doo the Merchant,
has led to your current quest.

Y ou are now riding with Abdulla and the Kattas on the merchant’s magical carpet,
recovered from the brigands’ stolen treasures. After a long and harrowing journey, you
at last arrive in the magnificent city of Shapeir. Unfortunately, just when you thought
you could take a well-earned rest, you discover that Shapeir has problems of its own. A
Hero is needed here, too!

Now you must become your character, and learn to think as he would, use his unique
skills to experience the land of Shapeir, and be a Hero on your Quest for Glory.

Living in this Crazy World

Just as inreal life, there are basic things a person must do to stay alive. You will need
to eat a couple of meals each day. If you are carrying food, you'll eat automatically, but
try not to run out of rations. Be especially careful not to run out of water. In the desert,
water is life itself.

You'll also need a certain amount of rest or sleep to regain Health, Stamina and
Magic points. Without rest or sleep you will use these points quickly. Sleep is best
accomplished in the safety of an inn,

Also, as in real life, basic necessities often cost money. To earn money, you can ful-
fill a quest (thereby obtaining a reward), or defeat a wealthy monster. The thief has
other options. The coin of the realm of Shapeir is unlike that of Spielburg. Here, 100
brass centimes = 1 golden dinar. Supplies such as food, equipment, magical spells
and healing potions can be purchased from the local merchants.

You will carry most of your equipment in a backpack. The amount you can carry is
determined by your strength and the weight of the equipment.

If for some reason you are in a hurry (a monster on your tail, or some such thing),
type run to move more quickly. Don’t run too far though, or you'll soon become tired.
Type walk to resume walking normally. Characters with points assigned to STEALTH
can also sneak when appropriate.

Finding Your Way Around Shapeir

The city of Shapeir. in contrast to the quaint Alpine village of Spielburg, is an ancient
and thriving metropolis. Many first-time visitors find Shapeir’s dense maze of streets
and alleyways almost overwhelming. Outside the gates is the seemingly endless
Shapeir Desert.

The keys to keeping yourself oriented in this vast realm are proper use of a map and
compass, taking advantage of such clues as street signs and the knowledge of local
citizens,

The Map

Purchasing a map in the game will help your character find his way around the streets
of Shapeir without getting hopelessly lost. Once your character has a map, you can
type “use map” anywhere in the streets and plazas of Shapeir. Then, simply place your
cursor on a map location, click the mouse button or press [ENTER], and your character



will walk directly there (unless, of course, something gets in his way). Until you have
visited a location (such as a particular shop), it will not show up on the map. As you ex-
plore the city, you will discover more places and your map will become more useful.
It’s better than getting lost.

To exit the map, press [ESC].

The Compass

A compass is a very useful item for navigating the trackless desert, or even finding
your way around town.

Street Signs

Even natives of Shapeir sometimes need a reminder as to where they are going and
which way they are heading. (Wizards in particular are notorious for having difficulty
inthis area.) For this reason, street signs are prominently posted at all major intersec-
tions and in the plazas. Plaza signs also often include direction symbols.

Asking Directions

One way to find locations you haven’t yet visited is to talk to the locals. A clear, con-
cise set of directions may be your reward. (Of course, that rather depends on whom you
ask!)

The Saurus and Desert Travel

Distances in the desert can be deceiving, and it is easy to lose your way. A well-
trained desert Saurus purchased from a reliable dealer can mean the difference between
exploring the desert in comfort and death from sunstroke or dehydration. Whether you
are walking or riding, never travel in the desert without a full waterskin. Night travel is
also a good way to avoid the blazing desert sun.

Winning the Game

When you complete Quest for Glory I successfully, you will be given the oppor-
tunity to save your character for use in Quest for Glory I11: Shadows of Darkness.
You will be asked to insert a formatted, writeable disk. Save this disk, as it will allow
you to begin Shadows of Darkness with your character from Trial by Fire.

Talking to Other Characters

You will meet many strange beings in Shapeir— some human, some otherwise.
Most of them know things that you don’t. By speaking with them you can gain some of
that knowledge.

Everyone you meet will understand sentences in which you ask about something in
their areas of expertise. You might ask about magic when speaking with the
Astrologer or the Enchantress, or ask about heroes when you visit the Adventurer’s
Guild Hall. You’ll want to jot down anything that seems important, as your conversa-
tions will provide you with most of the clues you'll need to save the land and once
more prove your worth as a Hero.

Many of the replies to your queries will suggest additional questions to ask, or lead
you to others who can provide you with useful information. For example, when you
ask Shameen about his inn, you will learn of the poet Omar.

Combat

The world is full of monsters and villains, and if you want to stay alive long enough
to become a Hero, you really ought to learn how to fight them. A clash will occur any
time a monster comes near enough to strike your character, or when you type fight.

Combat can take place in the room where you encounter a monster (allowing more
movement and strategy), or the screen may change to a close-up view of the monster.

When you encounter a monster, you will need to react quickly. You can throw dag-
gers or cast an appropriate spell while the monster is still at a distance, or you can type
fight to engage in battle. While in combat, you can cast some spells, but you won’t
have time to use healing or other potions.

In Quest for Glory Il combat, you can Attack, Parry, Dodge, or Cast spells (assum-
ing your character has the appropriate skills). All combat moves are made with the
numeric keypad (see chart). In general, the top row of keys (7, 8, and 9) represent At-
tacks, the middle row (4, 5, and 6) represent Parries, and the bottom row (1, 2, and 3)
cause your character to Dodge.

A Swing is a powerful blow that generally does more damage than a Thrust. How-
ever, it takes slightly longer, giving your opponent a better chance to defend himself.
Choose a High Swing or Low Swing to take advantage of weaknesses in your
opponent’s defense.



The direct Thrust is faster and harder to defend against, but leaves the attacker more
open to a counterthrust. Use a Thrust when accuracy is more important than damage, as
against a fast-moving but lightly-armored opponent.

All attacks benefit from careful planning and timing. Parry or Dodge your
opponent’s attacks while preparing your next blow. Attacking too quickly will make
you tire rapidly, and you will not hit as often as when you delay your thrusts.

The Parry, most often practiced by Fighters, is the art of blocking your opponent’s at-
tack with your weapon or shield. Parrying is quicker than dodging, and less tiring, but
must be timed properly to stop the enemy attack.

Dodging is the art of physically avoiding your opponent’s attacks. It is the only
defensive skill available to most Thieves and Magic Users, and can also be crucial to
Fighters when facing a clearly more dangerous opponent. Watch your enemy carefully
— anticipate his moves, and choose the proper Dodge accordingly.

Spells which may ordinarily be used in close combat include: Flame Dart, Force
Bolt, Zap, and Dazzle. When in doubt, Run Away (but watch your backside!)

0 il

In terms of combat strategies, timing and defense are both important in Quest for
Glory II. Try to strike when your opponent is ‘open,” and anticipate his attacks to better
defend yourself.

If you feel that the situation has gotten out of hand, you can type escape. or press
|[CTRL-E]toretreat.

Many battles can be avoided, and it might be wise at times to do so. Combat, how-
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ever, is one of the best ways for an aspiring Hero to practice and improve skills. Each
time you defeat a monster, you'll gain valuable experience that will increase your chan-
ces in future battles. Remember, always search the body of your opponent after win-
ning a battle, for some creatures carry money or other useful items.

In most cases, Status Bars are displayed during combat, keeping you informed of
Health, Stamina and Mana (magic energy) points for your character. As you become in-
jured, Health points diminish. You will use Stamina points as you work hard at fighting
or using your skills. When Stamina points are depleted, energy is drawn from Health.
When Health points are gone, the character is dead. A Health bar is also displayed for
your opponent, to show how badly it is injured. Your opponent’s Stamina is not dis-
played, since it would not be obvious to you during combat.

Thief Skills

Thief characters have two special skills; ‘Pick Locks® and *Stealth.” To use these
skills type pick lock to gain entrance to a locked door, or sneak to move quietly. When
you are finished *sneaking,” type walk to resume walking normally.

Magic

A Magic User begins the game with several spells. For a thorough discussion of
these spells and their effects, see the Famous Adventurer’s Correspondence School
Manual, pages 5-8. The spells he possesses will be listed in his inventory. Also listed
will be the number of Magic Points needed to cast a spell, and the level of skill the char-
acter has in each spell. His spell casting will improve with practice. To use a spell, type
cast (or press [Ctrl-C]), then type the name of the spell.

Targeting Spells

In Trial by Fire some spells must be targeted. If you cast such a spell, a targeting cur-
sor will appear onscreen. The targeting cursor is in the shape of crosshairs. Use the
mouse or [Arrow] keys to move the cursor to where you want to cast the spell, then
click your left mouse button or press [ENTER].

The spell’s success will depend on your skill in magic in general, and your skill with
that spell in particular. Practice pays.

11



How to Read this Manual

Throughout this manual we will use the following ways of representing information:

MENU COMMANDS will be capitalized.
Example: SAVE, RESTORE, QUIT, PAUSE GAME

Typed commands will appear as bold type.
Examples: ‘type: ask about shapeir’ ‘type: cd \sierra’

Portions of the command line not meant to be typed will not appear in bold type. For
example, in the line ‘type: cd \sierra’, “type:’ should not be typed.

[Keystrokes| will appear in brackets setting them off from the surrounding text. The
brackets are not keystrokes and should not be typed.

Examples: [Spacebar], [Tab], [PageUp]

Two or more keys that should be pressed at the same time will be separated by a
hyphen (-). This hyphen is not a keystroke, and should not be typed.

Examples: ‘Press [CTRL-I] to view your inventory.’

The terms “disk’, *floppy disk’, and “diskette’ are used interchangeably to refer to

either 3.5" or 5.25" external data storage disks. The term *hard disk” is used to referto a
fixed, non-removable data storage disk.

ALL SYSTEMS

PLEASE NOTE: If there is a README file on your game diskette, it may con-
tain important information and instructions that were not available at the time
the documentation and other materials for this game were printed. Failure to
review the README file before installing the program may result in unex-
pected consequences during the installation and/or running of the program.

GETTING STARTED: DISKETTE DRIVES

It is always advisable to make back-up copies of your master program diskettes to in-
crease the life of the masters and guard against accidents. Follow your computer’s in-
structions to make copies of all game diskettes.

If you will be playing from diskettes rather than a hard disk, you will also want to for-
mat a blank diskette for saving games. In fact, saving games to diskettes is a good idea,
even if you are playing the game from vour hard disk. Follow your computer’s instruc-
tions to format a blank diskette and keep it handy for saving your game as you play. For
some helpful tips on saving games, see the ‘Saving Your Game' (Page 22 ) and ‘Inter-
acting with Quest for Glory’ (Page 23) sections of this manual.

When installing your program, you may be prompted to insert a ‘Drivers” disk. If
you receive this prompt, please examine your disks and insert the disk marked
‘Drivers’ and press [ENTER], so that the appropriate drivers will be loaded. Some
games do not include a separate ‘Drivers’ disk.

MS-DOS
INSTALL THE GAME

Place the back-up copy you have made of the STARTUP diskette into your diskette
drive. Type the letter of the drive you have placed the diskette into followed by a colon
(forexample: a:), and press [ENTER]. Type: install and press [ENTER].

Answer the onscreen questions using the up and down [ Arrow | keys to highlight
your selections, then press [ENTER] to select.

HARD DISK INSTALLATION

You will be asked if you wish to install the game on your hard disk. If you do not
wish the game to be installed on your hard disk, press [ESC] to skip this step. If you
want to install the game on your hard disk, enter the letter designation of your hard disk
(usually C) and follow the prompts.

Please note: The install procedure will write a file named RESOURCE.CFG to
the STARTUP diskette. For the installation to be completed correctly, THE
STARTUP DISKETTE MUST NOT BE WRITE PROTECTED. No other files
on the STARTUP diskette are written or changed by the install command.

LOADING INSTRUCTIONS
After completing the INSTALL procedure:
From diskettes;

1. Place the STARTUP diskette into the A: drive.
2. Type: a: and press [ENTER].



3. Type: sierra and press [ENTER].

From hard disk:
1. From your root directory. type cd \sierra and press [ENTER].
2. Type trial and press [ENTER].

SAVING GAMES TO DISKETTES

\
Choose SAVE GAME, or type save, or press the [F5] key. The Save Game menu ‘
will appear., I

Choose CHANGE DIRECTORY . Backspace or press [Ctrl-C] to clear the command
line.

Type the letter of the drive you are using for saved games, followed by a colon (Ex-
ample: a:) and press |[ENTER].

Type the name of your saved game and press |[ENTER] to complete the SAVE
GAME procedure. If your disk for saving games is full, you may reformat it (this will
erase the saved games on the disk) and use it over, or use another formatted blank disk.

SAVING GAMES TO HARD DISK

If you choose to save games to the hard disk, the program will automatically try to
save to the game’s own directory, and name the games [NAME OF GAME DIREC-
TORY NSG.000,\SG.002, etc., through\SG.012 (SG stands for saved games). If you
run out of space for saving games, try one of the following alternatives:

1. Save additional games to a diskette.

2. Save games to a different directory by choosing CHANGE DIRECTORY from
the SAVE GAME menu (inside the game).

3. Delete the saved games and the saved game directory from your hard disk by fol-
lowing DOS instructions (outside the game). The program will create a new index

file within the game directory.
4. Create a new hard disk directory from DOS, using DOS instructions. l
ATARI ST xl

LOADING INSTRUCTIONS
Note: If you are using an Atari 520 ST without memory expansion, turn off all
desk accessories (rename .ACC extension .ACX) before running your Sierra game.
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1. If you are playing the game from diskettes: Place disk 1 in drive A, open the disk
by double-clicking on its icon. Start the game by double clicking on SIERRA.PRG.

2. If you are playing the game from a hard disk: Open the disk by double-clicking
on its icon, then open the game folder by double-clicking on the game folder icon.
Start the game by double-clicking on STERRA.PRG.

HARD DISK INSTALLATION
Please note: More than 512K of memory is needed in order to run Sierra games on

your Atari ST hard disk.

1. If you are playing from a hard disk, first make sure you have enough space on
the hard disk for the game — single-click on the disk icon, then select SHOW
INFO... from the File menu. Bytes Available should be at least 800,000 times the
number of floppy diskettes included with the game (400,000 times the number of
single-sided diskettes).

2. Open the hard disk by double-clicking on its icon.

3. Create a game folder by choosing NEW FOLDER...from the File menu. Open
the new folder by double-clicking on its icon.

4. Place disk #1 in drive A.

5. Copy the game disk into the new game folder by dragging the drive A icon into
the window you opened in Step 3. (Click on the drive icon, then while holding the
mouse button down, move the mouse arrow over the open window, then release the
button.)

6. Repeat steps 4 and 5 for each of the other game disks.

7. Put the master disks away in a safe place.
CHOOSE A MUSIC DEVICE (Optional)

Your Sierra game is initially set up to play music and sounds through the Atari ST's
internal speaker. If you have one of the supported MIDI synthesizers, you may run the
MUSIC program to have the game play music through the synthesizer.

1. Open the game disk/folder by double-clicking on its icon,
2. Run the MUSIC program by double-clicking on the MUSIC.PRG icon.
3. Select MUSIC DEVICE from the Options menu.

4, Select your synthesizer (or *Atari ST Internal Sound’) by clicking on the ap-
propriate button. Then click on OK.



5. Select INSTALL GAME from the File menu. This will replace the
RESOURCE.CFG file on your disk.

Please note: It is important to turn your synthesizer on before playing the game.

AMIGA
INSTALLING THE GAME

NOTE: RENAME your copies of all game disks to remove the words‘COPY
OF’ from the disk name. If the words ‘COPY OF’ are not removed from the
disk names of ALL the copies, the system will continue to ask for the original
disk, and will not run the game.

1. Boot your system with WorkBench, and double-click on the INSTALL icon.

2. Follow the on-screen prompts, choosing your selection with the mouse by click-
ing once on the item.

3. You will be asked if you wish to install the game on your hard disk. If you do
NOT wish the game to be installed on your hard disk. select NO. If you want to in-
stall the game on your hard disk, select YES.

4. Using your mouse, select which hard drive you wish to install the game onto.

5. Follow the on-screen prompts to complete the installation.

LOADING INSTRUCTIONS

From Floppy Diskettes:

L. If you have less than 1 megabyte of memory for your Amiga, disconnect any ex-
ternal drives while your system is oft.

2. Insert Disk #1 into drive DFO:.

3. Turn on your system.

From Hard Disk:
1. Load WorkBench and double-click on your hard disk icon.

2. Double-click on the SIERRA drawer.
3. Double-click on the drawer for the desired Sierra game.

4. Double-click on the game icon.

L SYSTEM
HOW TO PLAY

MOVING YOUR HERO

You may move your character on the screen with the [Arrow| keys, the numeric
keypad, or the mouse. To halt your character’s steps with the keypad. press the number
5, or press the last used direction key again. Do not attempt to move the character by
holding down the direction key. This will cause the character to start and stop con-
tinuously, resulting in very slow progress.

Using the mouse, position the arrow to where you want the character to move, then
click the left mouse button.
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SPECIAL CURSORS

Quest For Glory 11 uses special mouse cursors during certain modes of play. The
shape of each cursor shows you what actions are available to your character at that
time. If you are not using a mouse to play, the special cursor will usually appear in
the lower right corner of the screen to inform you of the current mode.
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-+— When you see this cursor, you
canmove your character and/or
type commands.

When you see this cursor, you
can neither move your character
nor type commands. —t
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This cursor is for aiming targeted spells or when throwing
something (see Targeting Spells, page 11). You will see this
cursor when you cast a spell that must be targeted. Move the
cursor to the place onscreen where you want to aim a spell.
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TRIAL BY FIRE MENUS

When you press [ESC], a menu bar will appear at the top of your screen with several
menus that can be opened to show the command choices available to you.

Use the left and right [Arrow] keys to open a menu, and the up and down [Arrow|
keys to highlight items within a menu.

If the menu choice opens a screen with two or more choices, use the [Tab| key to
move between the choices.

Press [ENTER] to select a highlighted command.

Press [ESC] to return to the game without choosing a command.

Menu Shortcut Command Keys

Sierra Menu
About Quest for Glory 11 ....... [Ctrl-G]

Helpiuaunsmsswnsne L]

Silly Clowns.......cceceeeeereecenn. [Ctrl-Y]
File Menu

SAVE G AME. casrevorssaresimssa D

Restore Game.........ccooeveeveenee. [F71]

Restart GRME .. ccuvssonveimimn [F9]

e P 1L 0]
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Game Menu

Faster Animation............cceeeue. +

Normal Animation .................
Slower Animation...................
[Ctrl-V]

Sound Volume ..........cocovinnnne

Turn Sound on/off..........ccccee.

Action Menu

Arcade Difficulty ...................
Game Detail .ccovvinivninisinns
Game Time Scale........ouee....
East Spell ..o

ESCApe s
Pause Game........coceeeveeceeeens

Repeat Last Command...........

Information Menu
o770 (3
Character Sheet ........cccococe.....
i1 T B R ——
ARk Abou e
g3 75T 1 R ————
Bl s
RegdMan oo
Compass Heading ..................

OTHER SHORTCUT KEYS
[Bpacebar] o
[Shift-Click] ...ovceniinreinn
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(F2]
(F4]

.[F6]

[F8]

[Ctrl-C]

[Ctrl-F]

[Ctrl-E]

-[Citrl-p]

(F3]

[Ctrl-T])/[Tab]
[Ctrl-S]
[Cul-D]

[Crl-A]

[Ctrl-T]
[Crrl-L]

[Crrl-R]

[Ctrl-H]/[Backspace]

Repeat last command
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